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1 Introduction 

This research is carried out as a project for the subject “Concepts, Measures and Methods”. It 

is a single-participant case study on note-taking habits of a student currently enrolled in the 

University of Twente. The goals of this study are to investigate why, when, how students take 

notes and whether they collaborate on them, and to analyse how Microsoft OneNote [1] and its 

functionality could help them in their note-taking process. The original research proposal can 

be seen in Appendix 1. 

Research methods, such as a diary study, interview, and field study, are used to gain insight 

into the topic after which findings are evaluated by conducting usability testing as a rapid 

evaluation method [2]. The result of this study is an overview of the note-taking habits of the 

participant and recommendations for improving the Microsoft OneNote platform. 

There are several reasons for conducting this minor-scale user research. A broader and more 

explorative one is to investigate the general note-taking habits of the current students of the 

University of Twente, including for what reasons, in what way and with whom they take notes. 

The goal is to analyse how students retain, share and collaborate on notes of their lectures and 

which digital platforms and paper-based options they use for those activities to understand what 

could be done to support their note-taking activities further.  

Furthermore, a more specific and product-related goal is to explore how Microsoft OneNote 

[1], which is part of the Microsoft Office 365 suite, could help students in their note-taking and 

collaborating process. Microsoft OneNote can be used to write down lecture notes, share and 

collaborate on conspectus and organise their schoolwork into one digital notebook that enables 

the creation of several sections, pages and subcategories. The study wishes to analyse how 

difficult it is to use Microsoft OneNote for the first time, given that the user has had prior 

experience with similar word processors, such as Microsoft Word, LibreOffice Word and 

Google Docs, and to help determine how the functionality and user interface of OneNote could 

be improved to fit the needs of first-time student users. 

In addition, a personal objective is to gain further insight into how to conduct user research the 

correct way by exploring and experimenting with some of the most common user research 

methods. 

The topic was chosen because the author of this study wanted to find out more about how other 

students take notes, especially because in the previous university of the author, most of the 
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lecture slides were uploaded online before the lecture, which made it easier to add notes to 

slides during the lecture. 

 

  



5 

 

2 Participants 

Due to the minor scale of this research, only one participant was recruited (hereafter referred 

to as the Participant). This participant was selected based on the following criteria: 

• Be a student currently enrolled in at least one university course 

• Take either digital or paper-based notes in lectures 

• Have prior experience with a word processor, i.e. Microsoft Word, Google Docs 

• Have no prior experience with Microsoft OneNote platform (important for usability 

testing activity only) 

• Not work for any competitors of Microsoft 

The recruitment was carried out via word of mouth and the Participant was an acquaintance of 

the conductor of this study. Initially, one other participant was considered based on the 

recommendation of conducting the research activities in pairs of students taking the “Concepts, 

Measures and Methods” course. However, since that potential participant did not meet the 

requirements (specifically, they did not take any notes), they were discarded from the selection. 

The Participant chosen for this research is an exchange student currently enrolled in a 

Psychology Bachelor’s course in the University of Twente. The same participant partook in all 

planned research activities; thus, it is not hereafter separately explained who the participants 

were in the sections describing research methods, activities and results. 

The Participant was asked for consent before every research activity. They were reminded of 

their rights to withdraw at any time with no penalties and consequences.  

The Participant was not given any money as an incentive to join the research. However, they 

were given confectionery as a sign of gratitude. 
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3 Methods 

Four different methods were used during the study to collect information. The methods relied 

on each of the previous method meaning that every additional method was used to clarify 

findings from the previous or to explore aspects that previous methods did not reveal. 

 

3.1 Diary study 

A diary study is a method to collect data on participant’s internal and external experiences 

described in their own words over a period of time. The diary study was used to gather 

longitudinal data on the Participant’s note-taking habits and frustrations and satisfactions 

accompanying the note-taking process over the course of four weeks (24 September - 19 

October). The diary was kept digitally using a Google Docs document shared with the 

Participant. The use of a shared Google Drive document meant that the conductor of this study 

had access to the entries at all times. 

The diary was kept as an incident diary, meaning that an entry was made as soon as possible 

after the Participant had encountered a note-taking activity either in a lecture or at home. 

Although the Participant was encouraged to keep their entries as free-formed as they wished, 

they were also provided with some focus areas they could use as guidelines for their entries: 

• Purpose of notes (Why did you take these notes?) 

• Time of taking notes 

• Name of the lecture/subject/course (If applicable) 

• The amount of notes (Number of pages) 

• Which special formatting was used, if any? If yes, why was special formatting used? 

• How did taking notes affect your understanding of the topic? 

• How did taking notes affect you paying attention in the lecture? (If applicable) 

Due to the scarcity of lectures and thus note-taking incidents, the Participant could write 1-2 

diary entries each week. In total, seven entries were made. 

The gathered data was mostly qualitative. It was read and analysed manually without the help 

of any software. Information from all the entries was grouped together based on the topics they 

handled.  
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3.2 Interview 

An individual in-person interview was conducted with the Participant on 10 October to look 

further into their views on note-taking in general, digital conspectus use, note sharing, and 

collaboration. The interview was semi-structured, meaning that although questions for the 

interview were prepared in advance, the participant was asked to elaborate on other relevant 

and interesting aspects that arose during the interview given that there was enough time to 

deviate from the predetermined course. 

Some of the prepared questions that were either asked in the original or slightly modified 

format in the interview: 

• In which situations (when) do you take notes?  

• Why do you take notes? 

• How do you take notes? (Note-taking techniques, special formatting) 

• What happens with the notes afterwards (after having taken them)? 

• Could notes be used collectively? 

• How do you feel about collaborating on notes, taking notes together? 

• What do you use to take notes? 

• What is your experience with {{what is used to take notes}}? 

• What could be different with {{what is used to take notes}}? 

The face-to-face interview was conducted at the home of the Participant for reasons of 

convenience and comfort and lasted for approximately one hour. During the interview, notes 

were taken on a laptop computer using Microsoft OneNote program and, after having received 

permission from the Participant, a recording of the interview using a mobile phone was started. 

The purpose of the audio recording was to enable the clarification of anything said during the 

interview later. The notes contained important keywords and some shortened forms were used 

for faster typing (i.e. ‘w’ instead of ‘with’ or loss of vocals in a word). 

At the beginning of the interview, the Participant was also reminded of the purpose of the 

interview and that they may refrain from answering any questions they wish and can stop the 

interview completely at any time. 
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3.3 Field study 

The field study was conducted on 15 October 2018 from 10:40-11:20 in one of the lecture halls 

in the University of Twente. During the field study, the participant was observed while 

attending one academic lecture of their study programme offered by the University of Twente 

to determine their note-taking habits in a real-life situation. Notes on the used platform and 

functionality were marked down using a laptop and Microsoft OneNote program. For privacy 

reasons, no screen- and video-recording solutions were used to capture the note-taking process.  

The participant could not be disturbed during the field study and think-aloud protocol could 

not be used due to it being distracting for both the Participant and everybody else attending the 

lecture, meaning that the field study was carried out as pure observation only. This part of the 

study was largely exploratory, and the goal was to see the Participant in action.  

The Participant was asked to send in the notes taken immediately after the field study and 

during the lecture break to avoid the original notes being modified and reformatted afterwards. 

The Participant also shared lecture slides with the conductor of the study as soon as they were 

uploaded by the lecturer. Three days after the field study the Participant was asked to share 

their notes again to compare whether and how they had been reformatted in the meanwhile. 

After the field study, the Participant was asked to clarify the confusing aspects the conductor 

noticed during the observation to find out the reason behind some of the actions of the 

Participant. 

 

3.4 Usability testing 

The in-person usability test was conducted on 21 October 2018 to analyse how easy it is for a 

first-time user to find the different functionalities that OneNote offers. For this reason, it was 

important that the Participant had not had any experience with OneNote before. The usability 

test was a summative evaluation, meaning that the final, launched product was evaluated. 

The user was orally presented with a list of tasks (see Appendix 2) containing both basic and 

advanced operations of taking, formatting and sharing notes. For each task, the success rate 

(whether the task was completed successfully or not) and time spent on task were measured. 

All in all, conducting the usability test took around 45 minutes. 

The activity was carried out at the Participant’s home using their personal computer with 

OneNote version 1809 (from Microsoft Office Professional Plus 2016 package) installed. 
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Participant’s laptop was used to reduce the number of mistakes caused by unfamiliar hardware 

(i.e. different keyboard layout) and to make the usability testing more convenient for the 

Participant. Due to this being a single-participant case study on a software solution in which 

hardware was considered less significant and inter-participant statistical analysis was not made, 

this could be allowed. 

The Participant was asked to apply the think-aloud protocol meaning that during the task 

completion they were continuously vocalising their thoughts and feelings. If the Participant 

stayed quiet for too long, the test administrator reminded them to continue to think aloud. After 

the test, the Participant was asked to briefly and retrospectively reflect on their activities and 

the difficulty of completing them. 

During the activity, the audio was recorded using a mobile phone and notes were taken on the 

laptop of the test administrator. The notes contained a description of how the task was carried 

out and additional comments on the process from the participant. Shortened forms (i.e. ‘bc’ 

instead of ‘because’) were used to take notes faster. Due to the Participant’s wish not to install 

any additional software on their laptop that was communicated immediately before the start of 

the activity, the screen was not recorded during the usability test. However, audio recording 

and observation of the Participant gave enough information to analyse the activity. 
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4 Results 

Due to this being a single-participant case study, it ought to be said that the results presented 

here are not generalisable and may not give an adequate overview of the note-taking habits of 

all students in the University of Twente. In order to make any statistically relevant conclusions, 

more participants need to be examined.  

However, the following results thoroughly describe the habits of the Participant observed and 

give some insight into the note-taking process of students. 

 

4.1 Diary study 

Results from the diary study cover findings over a longer period of time. The diary entries 

revealed that notes are taken either in a lecture or at home as paper summaries to prepare 

for an upcoming lecture. Most of the notes were taken in a morning lecture (10:45-12:20), 

although paper summaries were mainly done in the evenings. Length of the notes varied from 

one to ten pages. 

 

4.1.1 Aspects that have an impact on understanding and focus 

The ability to pay attention in the lecture was reported to have been affected by a variety of 

external and internal factors which can be divided by the positivity of the impact on the 

Participant. 

  



Positive impact  

+ Slides provided before the lecture 

+ Active listening in the lecture 

+ Having time to both listen to the 

lecturer, copy the slides and add their 

own notes 

+ Clarifying and explaining vaguely 

written slides 

+ Lecturer taking time to explain 

everything thoroughly 

+ Broad and general easy-to-understand 

topic 

+ Short paper with vaguely connected 

paragraphs (understanding of the 

current paragraph is not affected by the 

ability to remember the previous one) 

 

 

 

 

Negative impact 

− Slides seen for the first time in the 

lecture, not provided beforehand 

− No time to think about the content 

before having to add their own notes 

− Focusing on copying the slides instead 

of adding notes 

− Sharing attention between copying the 

slides and adding notes 

− Slides clustered with a lot of 

information 

− Graphs without legends 

− Fast pace of the lecture 

− Worrying about missing anything 

important 

− Not being able to understand the paper 

due to the specificity of the topic 

− Badly written or illogical paper 

− Frustration 

− Fatigue 

− Boring content 

 

4.1.2 Formatting 

Formatting differs a bit depending on whether the notes are taken for a lecture or to summarise 

a paper. For both of these, size 11 Calibri font with 1.15 spacing is used. All notes are taken 

using indented bullet-pointed lists (either dots or dashes). 

For lecture notes (see Figure 1), the following formatting guidelines emerge: 

• Main, first-level headings underlined 

• Sub-level headings in bold 

• No numbering for headings 

• Most important keywords in red colour 



12 

 

• Colour-coding to group notes together or divide them by concepts 

• Arrows (→) to separate text copied from slides from personal notes 

The Participant said that for lecture notes, correct formatting is very important because it gives 

them a general clean overlook of what has been written down. This makes it easier to study the 

material. Having enough space between lines of text is also essential because it makes the notes 

easier to read and for the brain to grasp the information, as reported by the Participant. 

 

Figure 1. Excerpt from formatted lecture notes. 

A quote from the Participant explaining why they use such clear formatting style for their 

lecture notes: “Just like it’s easier to study at a clean desk than at a cluttered one, so I’m very 

peculiar with my notes”. 

Formatting for paper summaries differs slightly: 

• Headings copied from paper 

• Headings written in bold 

• Numbering for headings 

For paper summaries, the Participant stated that formatting matters less and can be sloppier due 

to them not wanting to study the paper by heart afterwards. 

For handwritten notes, formatting matters the least because they are mostly temporary and will 

either be converted into a digital format or thrown away later.  

In general, the Participant reported that having a well-established system is a great way to stay 

organised because it makes it easier to find the information no matter which document created 

by the Participant they are presented with. 
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4.2 Interview 

Conducting the interview gave further insights into the reasons behind and tools used for taking 

notes, as well as the general life cycle of notes.  

 

4.2.1 Reasons for taking notes 

The Participant takes notes either in lectures or at home to summarize papers which are 

mandatory to read before the lectures. In general, notes are taken to prepare for an upcoming 

event (including marking down questions on the topic), to remember important information, to 

summarise material, and to understand the topic better. 

The Participant brought out the following reasons for taking notes in lectures: 

• To explain bullet points on lecture slides in case there is a possibility of not 

understanding them by just reading the slides, i.e. the wording on slides is vague, 

abstract, too specialised/professional or otherwise difficult to decipher.  

• To describe graphs on lecture slides in order to remember what they were about 

(“Psychologists don’t really believe in naming the graphs or the axis, so you’re not 

really sure what the graph is telling you.” - quote from the Participant). 

• To write down examples and additional information that is mentioned orally, but not 

written anywhere (also known as transcribing). 

• To define concepts (i.e. psychological theories) in their own words in order to 

understand them better. 

• To mark down the connection between information on slides and the topic being 

addressed. 

• To write down items they want to look up afterwards. 

The Participant brought out these reasons for writing their paper summaries: 

• To prepare for the lecture. 

• To shorten it down to 2-3 pages with the main message and methods, theories etc. 

• To study the scientific articles more easily before an exam. 

• To focus on summarising instead of understanding, thus focusing on individual 

sentences instead of the big picture: 

1. The paper is read one sentence at a time. 

2. For every sentence, it is contemplated whether the sentence is needed or not. 
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3. Important sentences are included in the summary. 

• To “cut away useless fat” (information) from the original paper in order to bring out 

the most important information and findings. 

• To understand what the paper is about. 

• To help recall what the paper was about afterwards. 

 

4.2.2 Programs used to take notes 

The Participant uses mainly two programs to take their notes. Both of these programs have 

some good and bad aspects in the eyes of the Participant (see Table 1). 

Foxit Reader [3] is used to take notes in the lecture if slides have been made available 

immediately before the lecture. Foxit Reader is a free PDF program similar in functionality to 

Adobe Acrobat Reader DC [4]. In Foxit Reader, “sticky notes” with comments can be added 

to PDF-files and later reviewed. When using Foxit Reader, the Participant does not have to 

retype the slides while taking the notes. However, they do retype the slides with added 

comments after the lecture to have them in the same format as everything else. 

Microsoft Word [5] is used in other cases: to copy the slides either in lecture or at home (when 

Foxit Reader was used during the lecture) or to summarise papers. 
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Table 1. Participant’s view on Foxit Reader and Microsoft Word. 

 Positive Negative User-recommended 

improvements 

Foxit 

Reader 

+ Note placement 

shows where the 

note belongs to 

(position) 

− Froze once None 

Microsoft 

Word 

+ Partial 

reconstruction of the 

saved document in 

case the program 

shut down 

unexpectedly 

− Freezes often 

− The document 

does not save 

automatically 

− Easy to forget to 

save the document 

at the beginning 

(when created) 

− Automatic 

correction 

mistakes take time 

to fix 

Automatic correction 

based on repeated activities 

is annoying when it does 

not match the user’s note-

taking system and should 

be removed as a feature. 

 

Using Foxit Reader is preferred because it enables the Participant to focus on paying attention, 

not on retyping the slides during the lecture. However, they stated that using Foxit Reader 

means having to do more work in the end due to having to convert the notes to a suitable Word 

document format which would fit with the system the Participant has for taking notes. 

Therefore, the ideal course of action is to have slides available and copied to a Word document 

before the lecture and adding personal notes to those during the class. 

In addition, the Participant stressed that any handwritten notes taken during the lecture will be 

converted to a digital format afterwards. 

 

4.2.3 The life cycle of notes 

For this Participant, the note-taking process is quite specific. They do not copy and paste the 

information but instead retype the lecture slides word-by-word - a process which they refer to 
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as “copying the slides”. Because of that, their notes look almost identical to the slides (see 

Appendix 5). After retyping the slides, they add their own comments and format the document. 

The finished document is printed, highlighted, and studied carefully. When notes are not 

needed anymore (i.e. the subject has been passed), the digital versions are kept indefinitely, but 

physical copies are first archived and then discarded. 

Therefore, the general life cycle of the notes is as follows (also see Figure 2): 

1. Retyping text from presentation slides to a Word document prior to or during a lecture 

2. Adding personal notes to copied text in the Word document during the lecture 

3. Re-reading notes after the lecture. If necessary, any missing information is added. 

4. Formatting the notes (see Chapter 0) 

5. Printing out the document 

6. Colour-coding the printed out document using highlighters (see Appendix 3 and 

Appendix 4) 

• Pink for first-level headings 

• Green for sub-level headings 

• Yellow for bullet points 

7. Rewriting the most important parts of the notes by hand on a separate paper (see  

Appendix 6) 

8. Archiving notes after the exam 

9. Throwing away paper-based notes if certain they are not needed anymore 

 

 

Figure 2. A diagram on the life cycle of notes. 

Thus, it can be seen that there is a clear system of taking, keeping and discarding notes. 
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4.2.4 Collaborating on notes 

The Participant of this study is not keen on collaborating with others when taking notes. They 

explained that multiple people working on their notes would confuse and distract them. 

Therefore, they prefer to take notes on their own with the exception of sharing notes among 

their group of friends in case somebody was unable to attend the lecture or wishes to compare 

their notes. 

The Participant is not opposed to sharing their notes with other students and has even 

considered selling their paper summaries on the online platform Athena [6] (Quote from the 

Participant: “I’m going to take notes anyway, so why not earn money with them?”). However, 

the Participant usually politely refuses to share their notes if it is clear that the person asking 

for the document is taking advantage of them and freeloading. 

The Participant occasionally accepts notes from others but must transform those notes to match 

their well-established system in this case. 

All in all, the Participant considers it a good idea to collaborate on notes but admits that this 

process is not well suited for their system. 

 

4.3 Field study 

The field study relieved the Participant’s systematisation preferences even further by enabling 

to have a look at how systematically the files on their computer are organised. For every 

subject, there is a separate folder in which documents (slides, notes, papers) are organised by 

subjects, assignments, exams, lectures and literature. 

During the session, it became clear that when the lecturer moved over slides quickly, the 

Participant did not have enough time to retype everything. However, because they were 

listening to the lecturer, they were often able to paraphrase the content. Graphs and figures 

on slides were described via the use of text. Occasionally the Participant went back to a 

previous section to edit either the content or formatting of the notes. Most important general 

concepts were bolded and marked in red colour, while lower-level, more specific concepts were 

marked in italics and red. 

Typing was done in a fast way and often mistakes occurred. In addition to correcting them 

manually, Microsoft Word’s correction recommendations and automatic correction were 

used. Word processor also learned from the Participant’s formatting style (see Chapter 0) and 
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started to automatically format notes in a similar way. Furthermore, adding a new hyphen 

converted it to an unordered list and the first letter of each phrase in those lists was capitalised 

automatically. 

Hyphens (-) were used for listing items written on slides, and arrows (→) for adding additional 

info and summarising the content of a section at the bottom. Sometimes, the ordering of items 

in the Participant’s notes differed from the one on lecture slides. 

The document was first saved 15 minutes after the start of the lecture. 

Comparing the original document obtained immediately after the field study with a version of 

the same document sent in 3 days later, no changes to content or formatting were observed, 

meaning that the Participant did not do any corrections to the file after the lecture. 

 

4.4 Usability testing 

The detailed findings of the usability testing activity are presented in Appendix 7. Time spent 

on task varied from 5 seconds to over 4 minutes. The average time spent on task was 1 minute 

and 14 seconds. Out of the 20 tasks, 15 were carried out successfully, causing a success rate 

of 75%. 

 

4.4.1 Unsuccessful tasks 

The following tasks could not be completed due to the reasons presented below. 

Changing the location of the notebook 

The Participant explored the Quick Access menu bar and File submenu thoroughly but did not 

come across the notebook properties section which can be opened by right-clicking on the title 

of the notebook (see Figure 3). The participant was confused by the save icon, exporting 

submenu, and send option. 
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Figure 3. Notebook properties location. 

Write a word in your native language and translate it to English using OneNote tools 

The Participant did not know where this option could be located and started to browse through 

menus one by one until they found the translation option in the Review submenu. By clicking 

on the translate button they were presented with an error dialogue informing them about the 

translated text being forwarded to third parties. 

It was not intuitive that the word had to be selected before clicking on the translate button. 

The translation was difficult to notice because it was written in a fine cursive print in the lower 

part of the section (see Appendix 8). Instead, the Participant stopped on the definition presented 

in the original language (German).  

The Participant was unable to find a button which would replace the original word with the 

translation. 
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Insert a screen clipping 

The Participant did not find the right option in menus (Insert -> Images -> Screen Clipping) 

and tried using the lasso select tool instead. They managed to cut and paste existing text in the 

notebook with that one, but during the process original formatting (spacing, indents) was lost. 

Share the notebook with a friend via e-mail 

The Participant did not have Outlook installed correctly and was presented with an error 

message. 

Share the notebook with a friend via link 

The Participant started by looking through menus on the Quick Access bar before moving to 

the File menu where sharing options are located. 

The Participant did not have OneDrive connected to OneNote correctly and was presented with 

an error message. 

 

4.4.2 Recommendations for improvements 

In order to make OneNote easier to grasp and more suitable for first-time users, the following 

recommendations for improvements are proposed: 

• Providing clear descriptive error messages with possible solutions to inform the user 

about what went wrong and what can be done to recover from the error. 

• Directing the user to a specific, corresponding help page when the help button is pressed 

during an action instead of presenting them with a general one containing unnecessary 

and unhelpful off-topic information. 
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• Having a search box similar to the one in Microsoft Word (see Figure 4) will make it 

easier for people to find the option they are looking for by typing it in the search box 

instead of browsing through menus to find the right one. 

 

Figure 4. Smart search box in Microsoft Word. 

• Adding the Share button to the menu bar as it is in Microsoft Word (see Figure 5) will 

make sharing and collaborating easier by not having to look through menus to find the 

sharing option. Furthermore, it will homogenize the user interfaces of Word and 

OneNote to make switching between those programs simpler. 

 

Figure 5. Sharing button in Microsoft Word. 

• Converting online images to a correct format automatically when they are inserted into 

the notebook instead of presenting the user with a list of unfamiliar format options 

which do not work and produce a vague, uninformative error message. 

• Making translated words in the translation window (see Appendix 8) pop out from 

surrounding text using colours and removing unnecessary extra information. 

• Adding a button in the translation window to replace the word being translated faster 

(with a click of a button) and without having to copy-paste the translation manually. 

• Automatically detecting the language of the word being translated and the language of 

the document, so that the user does not have to choose the right ones again every time 

they want to translate a word. 
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• Adding the option to turn off automatic formula completion (OneNote entering the 

answer when space is inserted after equation mark). 

Implementing those recommendations would make OneNote easier for first-time users familiar 

with other similar word processors. Furthermore, keeping the user interface and layout as 

similar as possible across Microsoft Office solutions is great for the brand and will make 

adopting additional software in the suite more intuitive because users already know where to 

find most of the common functionality. Currently, OneNote differs slightly from Word which 

makes it more difficult to use. 
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5 Discussion 

Due to this being a single-participant study, the results may just be a deviation from the norm 

and cannot be generalised to describe the note-taking habits of the whole population of students 

in the University of Twente. However, they give a thorough overview of one particular student 

who was studied during the research via the use of a variety of methods. 

During this user research, it was found out that the Participant has a clear system for formatting, 

taking, retaining and discarding their notes. There are several aspects affecting the ability to 

pay attention during the note-taking process and multiple reasons for taking notes. It was 

discovered that this participant is not keen on sharing and collaborating on their notes. Common 

programs used to take notes are Microsoft Word and Foxit Reader. 

The system the Participant uses to take notes has most likely been established over time to fit 

the particular needs of the Participant. This may also explain why it is so difficult for them to 

work on their notes together with others who have developed a different system of taking notes. 

In order to help this Participant in their note-taking process, lecturers should start uploading 

slides before the lecture. This would give the student enough time to familiarise themselves 

with the slides and copy them to their conspectus document for easier note-taking during class. 

Currently, the Participant must focus on listening to what the lecturer is saying, retyping the 

presentation slides and adding their own notes which has an effect on attention. 

It was expected that the Participant goes over their notes after a lecture and makes major 

changes in both content and formatting. However, results from the field study revealed that no 

corrections were made to the original document over a course of 3 days. The reason for that 

might be that in this case, the Participant had enough time during class to focus on those 

aspects. It is unclear whether this is the norm based on a single field study session. 

Furthermore, although the Participant was impressed with the functionality offered by 

Microsoft OneNote, the usability testing revealed several aspects of the program that can be 

improved further. The problematic areas may be caused either by the Participant’s level of 

technical expertise or by general flaws in the design of the program. To verify this, additional 

testing with other users ought to be carried out. 
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5.1 Reflection on methods 

Using all of those user research methods was redundant because most of the information was 

communicated during the interview. Therefore, a single interview or a combination of field 

study and interview could have been conducted instead of having a separate diary study, 

interview and field study. 

While diary study, interview and field study gave information on the note-taking habits of a 

particular participant, the usability test focused on analysing a specific program, how easy it is 

to use and what could be improved further. 

However, the success of all of those methods was largely due to having a dutiful participant 

who needed no reminders on filling in the diary and was very talkative during the interview 

and usability testing activities. In case of a less dutiful participant, the diary study would not 

have been as effective and would have had to be replaced with another activity (i.e. interview) 

to obtain the same amount of data. 

 

5.1.1 Reflection on the diary study 

The process of this research activity went smoothly, mostly because the Participant was dutiful 

and did not need any reminders on writing new entries. Keeping the diary digitally in a shared 

document enabled to review the Participant’s entries whenever it was needed and give feedback 

or guidelines to the Participant, if necessary, to improve the entries even further. For example, 

the first diary entry was rather vague and general due to a minor misinterpretation of the activity 

description I wrote. However, after reminding the participant to focus on specific incidents and 

how they made them feel, the quality of entries improved drastically. Thus, I concluded that it 

is very important to be as thorough in activity descriptions presented to participants as possible 

and to observe at least a couple of initial entries to ensure they contain appropriate information 

and, if necessary and possible, reach out to the participant to correct the entries. 

I debated whether to make the diary in a text editor based document or in the form of a survey 

depending on whether I should let the participants review their writings. Being able to read and 

edit former entries may tempt the participants to change them at a later point in time. However, 

seeing their previous diary entries may inspire them to write more and help remember what to 

write. In this study, I used the text editor based format and my Participant said that they 

preferred seeing previous entries. However, I would like to compare it to a format in which 

participant can only enter text, not view previous entries.  
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Analysing the entries manually was doable for a single-participant study. However, with a diary 

study lasting longer or including more participants, special programmes should be used to 

analyse the data. 

 

5.1.2 Reflection on the interview 

Conducting the interview and taking notes at the same time was bothersome, which is why I 

completely understand why it is recommended to have two persons at an interview - one to talk 

to the participant and another to write down what was said. Since I recorded the interview, 

transcribing it afterwards would have been another option. However, I felt more confident 

knowing that I also took notes in case something went wrong with the recording. Since 

transcribing everything would be quite time-consuming, I only brought out the general ideas 

and most important quotes to present in the results. Mostly, I relied upon my notes. I used a lot 

of shortened forms for writing, but it was still difficult to keep up with the interviewee at one 

point. Language barrier posed a problem for both of us. It was nothing major, all thoughts could 

be communicated, but occasionally I found myself writing down words in my native language 

when I could not recall the correct word in English. 

Although I was acquainted with the Participant beforehand, conducting the interview according 

to the “rules” made it feel very formal to both me and the Participant. However, we did not let 

that stop us from developing rapport.  

I was constantly analysing my behaviour, facial expressions and questions so that they were 

not biased in any way. I tried to refrain from formulating leading and loaded questions which 

could affect the Participant’s answers. Normally, I preferred open-ended questions. I would 

like to think that I managed that quite well considering it was my first time conducting such an 

interview. 

 

5.1.3 Reflection on the field study 

It was good to see the Participant in action. However, since note-taking is a rather basic and 

repetitive activity, I felt that observing the Participant for nearly 30 minutes might have been 

too much. The field study gave me little to no new information due to the interview carried out 

beforehand being so thorough. It might have been more interesting to start with the field study 

and then conduct the interview afterwards. Due to the clarification questions, it can be said that 
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there even was a tiny interview after the observation, but most of the information had already 

been gathered before. 

It would have been better to conduct additional field studies to compare how the Participant 

acts when slides are uploaded before the lecture or how they take notes for a preparatory 

reading task at home. However, due to time limitations and because it is hard to predict whether 

slides will be uploaded before the lecture, additional field studies were not done. 

 

5.1.4 Reflection on the usability testing 

It would have been great to be able to capture the screen during the usability testing or at least 

know the Participant’s preferences beforehand. In this case, the wish to not share the screen 

was not communicated before the activity. Thus, next time, screen capturing could be made a 

prerequisite or the devices (in this case, a laptop) of the conductor could be used instead. 

Fortunately, audio recording combined with the observation notes were sufficient this time. 

Applying the think-aloud protocol was a bit complicated because I was not sure how often I 

should remind the participant to speak their mind when they were not vocalising their thoughts. 

Luckily, they rarely trailed off. Furthermore, speaking aloud made it easier to connect the 

comments on the ongoing task to corresponding notes when listening to the audio recording 

afterwards. 

Although this activity was conducted using the Participant’s personal computer, I think it 

would have been better to do it in a “lab” setting with one dedicated computer which is sure to 

perform well and have all the appropriate software on it already. This is especially important 

when there is more than one participant so as to reduce the variability between participants 

caused by skills and the familiarity of their own hardware. 
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6 Conclusion and recommendations 

This user research gives insights into the note-taking habits of one individual student. During 

the study, note-taking habits of an individual were observed via a diary study, an interview and 

a field study. A usability test was conducted to observe how easy it is to use Microsoft OneNote 

for the first time and what can be improved to make the program simpler. 

The study reveals that the observed Participant has a clearly established formatting style, 

process and reasons for taking notes. They mainly use Microsoft Word for taking their notes 

and do not favour collaborating on their notes. 

Many functional possibilities of Microsoft OneNote are tested to find areas which can be 

improved further to fit the needs of first-time users. The most important recommendations 

include homogenizing user interfaces across different Microsoft Office applications, improving 

the clarity of error messages and guidelines users are presented with, directing users to a 

relevant help page, and adding a multifunctional search bar to make looking for the needed 

functionality easier. 

In order to make this user research scalable and descriptive of a wider range of students, 

additional research ought to be carried out with more participants. This would enable to 

compare whether the activities observed in this study are common for all students or just this 

Participant.  

For future research, it is recommended to use gaze tracking devices during the usability testing 

activity to find out where exactly participants focus when they are looking for certain 

functionalities. This would give information on how to organise menus in a better, more 

intuitive way. 

An additional field study could be repeated when slides are available beforehand to compare 

those situations. Other sessions ought to be conducted to observe the Participant during writing 

paper summaries and studying based on the notes. 
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Appendix 1 - Original research proposal 
Introduction and History 

Microsoft OneNote is part of the Microsoft Office 365 suite and is meant for easier note-taking. 

It can be used by university students to write down lecture notes, share and collaborate on 

conspectus and organise their schoolwork in one digital notebook. 

This document is a proposal for a research which will be conducted as part of the “Concepts, 

Measures and Methods” course. The research looks into how current students of the University 

of Twente retain, share and collaborate on notes of their lectures. The study also analyses how 

difficult it is to use Microsoft OneNote for the first time, given that the user has had prior 

experience with similar word processors. Research methods, such as a diary study, interview, 

and field study, are used to gain insight into the topic after which findings are evaluated by 

conducting usability testing as a rapid evaluation method. The result of this study is a proposal 

for improvements to the OneNote platform. 

Objectives, Measures, and Scope of the Study 

Four main techniques will be used during this research. A diary study is a method to collect 

data of participant’s internal and external experiences described in their own words over a 

period of time. The diary can be kept either digitally or on paper. An interview is a structured 

informative conversation with the participant. During a field study, participants are being 

observed carrying out tasks in their natural environments. Usability testing helps to analyse 

how easy it is for participants to use OneNote for note-taking and collaboration. 

The objectives of these activities are as follows: 

• To find out which platforms and functionalities students currently use to take lecture 

notes; 

• To help determine how the functionality and user interface of OneNote could be 

improved for first-time student users. 

During the activities the following data will be collected: 

• Demographic information of each participant (e.g., university, study programme) 

• Note-taking habits of participants 

• Note collaboration habits of participants 
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• The difficulty level of carrying out basic note-taking, formatting, and collaboration 

tasks on the OneNote platform 

The information collected from these activities will be used to improve Microsoft OneNote 

with focus on university students. 

Methods 

Prior to all activities, consent and nondisclosure agreements will have to be signed. The data 

collected by applying the following methods will be analysed and presented to the product 

team alongside with suggestions for improvements. 

Diary study 

The participant is asked to keep a free-form diary for four weeks. The diary can be either digital 

or on paper depending on the participant’s preferences. The activity will be carried out over 

the course of four weeks from 21 September to 19 October. The participant will write down 

their weekly experience with their current note-taking platform. They will be given some bullet 

points on which they ought to focus when writing the diary. 

Interview 

An individual interview will be conducted with the participant between 28 September and 12 

October. The participant will be asked questions regarding note-taking in general, digital 

conspectus use, note sharing, and collaboration. Although questions for the interview will be 

prepared in advance, the participant is asked to elaborate on other relevant and interesting 

aspects that may arise during the interview given that there is enough time to deviate from the 

predetermined course. The maximum length of the interview will be one hour. 

Field study 

During the field study, the participant will be observed while attending one academic lecture 

in the University of Twente to determine their note-taking habits in a real-life situation. Notes 

on the most commonly used platform and functionality will be marked down. The participant 

will not be disturbed during the field study meaning that this part is carried out as pure 

observation only. However, immediately after the lecture, the user will be asked to reflect 

briefly on what happened in order to gain further insight on their note-taking experience. Three 

days after the field study the user will be asked to share their notes again. If they have been 
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formatted in the meantime, the user will be asked to reflect on changes made and the reason 

behind it. The field study will be conducted between 12 October and 19 October. 

Usability testing 

In usability testing activity, the participant is presented with a task to carry out using Microsoft 

OneNote. The task contains basic operations of taking, formatting and sharing notes. 

• The participant will first read the task and make sure they understand it. The test 

administrator will clarify any parts that are unclear. 

• The participant will carry out the given task while applying the think-aloud protocol, 

meaning that they continuously vocalise their thoughts during the task completion. 

• If the participant stays quiet for too long, the test administrator will remind them to 

continue to think aloud. 

• After completing the task, the participant is asked to retrospectively reflect on their 

activities and the difficulty of completing them. 

For this activity, it is important that that participant has had no prior experience with OneNote 

before to determine the problematic areas of first-time use. Usability testing will be performed 

between 19 October and 26 October. 

Participants 

Participants must meet the following criteria in order to participate in the research: 

• Be a student currently enrolled in at least one university course 

• Have prior experience with a word processor, i.e. Microsoft Word, Google Docs 

• Have no prior experience with Microsoft OneNote platform (for usability testing 

activity only) 

• Not work for any competitors of Microsoft 

Recruitment 

The conductor of this study, Eva Maria Veitmaa, will perform recruiting for all activities. 

Suitable participants will be selected amongst students of the course “Concepts, Measures and 

Methods”. A minimum of one participant is required. 
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Incentives 

The participants will not receive any monetary compensation. Instead, they have the option of 

using the author of this study as a participant in their research in turn. 

Responsibilities and Proposed Schedule 

The conductor of this study, Eva Maria Veitmaa, is responsible for the detailed study plan, 

recruitment, carrying out all aforementioned research activities, collecting and analysing the 

data, and presenting final results both orally and in the form of a written report with 

recommendations. 

The lecturer of this course, professor Jan Maarten Schraagen, is responsible for reviewing and 

approving the study proposal (this document). 

Preparation Timeline 

Work package Owner Estimated time 

to complete 

Date forecast Status 

Recruit participants EMV 30 minutes 22 September TBD 

Prepare diary study EMV 30 minutes 21 September TBD 

Communicate diary study to the 

participant 

EMV 10 minutes 22 September TBD 

Analyse data from the diary 

study 

EMV 2 days 24 October TBD 

Prepare interview questions EMV 2 hours 27 September TBD 

Conduct the interview session EMV 1 hour 5 October TBD 

Analyse data from the interview 

session 

EMV 2 days 12 October TBD 

Conduct the field study session EMV 2 hours 17 October TBD 

Analyse data from the field 

study session 

EMV 2 days 19 October TBD 

Prepare the usability testing 

session 

EMV 2 hours 26 October TBD 

Conduct the usability testing 

session 

EMV 1 hour 22 October TBD 
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Analyse data from the usability 

testing session 

EMV 2 days 24 October TBD 

Create a draft report EMV 1 week 24 October TBD 

Review and comment on the 

report 

EMV 2 days 26 October TBD 

Submit final report EMV 1 day 26 October TBD 
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Appendix 2 - Usability testing tasks 
 

During the usability testing activity, the Participant was presented with the following tasks: 

• Create a new notebook 

• Change the location of the created notebook 

• Add two sections (tabs) to the notebook 

• Add three pages to one of the sections 

• Make one of the pages a subpage of another 

• Write the title by hand, not via typing 

• Convert the handwritten title to text using OneNote tools 

• Insert today's date and time using OneNote tools 

• Insert a formula a^2 + b^2 = c^2 

• Insert a numerical equation with spaces around the equation mark (=), i.e. 2+2 = 4 

• Write a word in your native language and translate it to English using OneNote tools 

• Add a list with three items 

• Add a ‘to-do’ tag to one of the list elements 

• Add a ‘critical’ tag to one of the list elements 

• Mark the to-do tag as done 

• Insert an online picture using OneNote tools   

• Insert a screen clipping 

• Insert a PDF file 

• Share the notebook with a friend via e-mail 

• Share the notebook with a friend via link 
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Appendix 3 - Printed and colour-coded 
lecture notes 
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Appendix 4 - Printed and colour-coded 
paper summary 
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39 

 

Appendix 5 - Comparison between a 
lecture slide and notes based on it 

 

Figure 6. Original lecture slide. Psychology of Safety lecture slides (Renate Geurts) [15 Oct 2018]. 

 

 

Figure 7. Notes based on the lecture slide.   
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Appendix 6 - Participant’s desk during the 
process of colour-coding and studying 
print-out notes 
 

 

  



Appendix 7 - Overview of the usability testing findings 
 

Task Time spent 

on task 

(min) 

Success Comments 

Create a new notebook 0:48 Yes Emptiness of a new notebook was confusing 

Change the location of the notebook 3:02 No Confused by the save icon, exporting submenu, and send option.  

 

Unable to find the notebook properties where location can be changed. 

Add two sections (tabs) to the notebook 0:06 Yes - 

Add three pages to one of the sections 0:06 Yes Colourful sidebar drew the eye 

Make one of the pages a subpage of 

another 

0:05 Yes Found the drag-and-drop option first and right-click option later. 

 

Confused by drag-and-drop because unclear if page was moved or 

something else happened. 

Write the title by hand, not via typing 0:30 Yes Title shown in the menu bar of the program changed with a delay 

Convert the handwritten title to text using 

OneNote tools 

1:22 Yes Difficulties with finding the correct button in the menu. 

 

Tried selecting and right-clicking the text instead. 
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Task Time spent 

on task 

(min) 

Success Comments 

Confused by not having to select the text they wish to convert. 

 

Expected to see the opposite option of converting typed text back to 

handwritten text as well. 

Insert date and time using OneNote tools 0:24 Yes Added date and time separately (first “Date”, then “Time”) instead of 

using the “Date & Time” option causing them to appear in different 

textboxes. 

Insert a formula a^2 + b^2 = c^2 0:18 Yes Formula was given in “Equation” submenu already so there was no 

need to type anything out 

Insert a numerical equation 0:16 Yes Confused by OneNote automatically completing the calculation when 

space was entered after equation mark (=). 

 

Needs getting used to and active focusing to not fill it out manually as 

well. 

 

Liked the idea. 
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Task Time spent 

on task 

(min) 

Success Comments 

Write a word in your native language 

(German) and translate it to English using 

OneNote tools 

4:16 No No idea where to start looking for the option, so start with “Home” 

menu. 

 

Not intuitive that word had to be selected before clicking on the 

translate button. 

 

Confused by German definition. 

 

Translation was presented lower, in a fine cursive print, and therefore 

harder to notice. 

 

Unable to find a button which would replace the original word with 

translation. 

Add a list with three items 0:08 Yes Typing a number followed by space automatically turned it to a 

numbered list which was familiar from MS Word. 

Add a to-do tag to one of the list elements 0:49 Yes First looked at the “Insert” menu because that’s where everything is 

added. 
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Task Time spent 

on task 

(min) 

Success Comments 

Found it via right-clicking on the list element before also noticing the 

option in the “Home” menu. 

Add a ‘critical’ tag to one of the list 

elements 

1:29 Yes Tried looking for it in the “Home” menu based on the previous task 

but did not click the expanding button to reveal other tagging options. 

 

Found the correct tag by right-clicking on the word and noticing the 

expanding button there. 

Mark the to-do tag as done 0:06 Yes Clicking on the box was intuitive 

Insert an online picture using OneNote 

tools 

2:54 Yes A lot of trouble with converting the first picture to a correct format. 

Had to use a different picture because they could not figure out the 

correct format which would not produce an error. 

 

Error message was vague and did not give enough information about 

the mistake and what should be done to resolve it. 

 

Clicking the “Help” button did not direct to a specific on-topic help 

page, but to a general one. The Participant did not want to start 
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Task Time spent 

on task 

(min) 

Success Comments 

looking for the right section from the overflow of information, so they 

closed the help window. 

 

Confused by another image working without the need to convert. 

 

Disliked having to use Bing due to it being the only option. 

 

Liked being able to move the picture around without it changing the 

layout of everything else on page as happens in Word. 

 

Liked how moving the image outside of the current canvas area made 

the workplace canvas bigger and how moving the image back made it 

smaller again. 

Insert a screen clipping 2:47 No Unable to find the right option in menus. 

 

Tried using the lasso select tool instead. Managed to cut and paste 

existing text with that one, but formatting (spacing, indents) was reset. 
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Task Time spent 

on task 

(min) 

Success Comments 

Insert a PDF file 1:28 Yes Added the PDF as a file attachment (link to the document), not as a 

file printout (image of the document). 

 

Confused by attached file opening with a lag. 

Share the notebook with a friend via e-

mail 

0:37 No Did not have Outlook installed correctly. 

Share the notebook with a friend via link 3:22 No Looked for the option in the Quick Access toolbar instead of the File 

menu. 

 

Did not have OneDrive connected correctly.  

 

Average time spent on task:   1:14 

Success rate: 75% 

  



Appendix 8 - Screen capture of the 
translation tool in OneNote 


